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Introduction 

Introduction to Microsoft Excel 

Welcome to Microsoft Excel training with The Capacity Collective! We are glad you are here.  

Microsoft Excel, part of the Microsoft Office Suite, is a powerful tool for collecting, storing and analyzing 

the stories of your program. What you can do with Excel is almost limitless, but it can be very 

intimidating. Even those of us who use it daily find we are still learning, especially from others. With 

Excel, there is always more to learn, and there are probably three other ways to do whatever function 

you are doing. We hope we can help you build your confidence with Excel so you can start, and/or 

continue, to demonstrate the incredible work of your programs using this functionality. 

We know a lot of the training out there for Excel revolves around the business sector, which can make it 

harder to understand the concepts. We have designed our workshops around the work you do as 

program coordinators, program managers, directors and other staff working in community 

organizations.  

This Participant Guide is meant to provide an overview of the functions we find most useful in non-profit 

work. It should help you through today’s workshop and be an ongoing resource after the workshops are 

over. We hope you find it helpful. 

If you would like to reproduce any part of the document, or adapt the guide for your own purposes, we 

would appreciate you letting us know. Thank you for supporting our work! 

 

How to Use This Guide 

As you navigate the guide, be on the lookout for the following: 

 

Throughout the guide you will see Keyboard Shortcuts, some of which 

you may recognize from other Microsoft Office Suite products.  

Note: If you are a PC user, use the Control (CTRL) button where specified. 

If you are a Mac user, use the Command (CMD) button anywhere you see 

CTRL in the guide. 
 

Excel Tips: Look for this icon for bonus Excel tips and tricks  

 

 

 

  

On a Mac: 

While most functions in Excel work similarly for PCs or Macs, there are a few differences here and there. 

Look for teal boxes with white writing for directions specific to Mac users. 

Keyboard Shortcuts 

 
+  : 

Create a New 
Workbook 

 
+  : 

Open an Existing 
Workbook 

 

N 

O 
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Getting Support 

Tips and Tricks for Answering Your Excel Questions 

It simply is not possible for you to know (and remember!) every function in Excel. Even those who work 

in Excel everyday have to Google things on a regular basis. There is no shame in asking for help. Below 

are some tips and tricks for answering your Excel questions. 

                  It!  

No matter what it is, we can almost guarantee that Google can lead you to some solutions. 

Example Issue: You are working with a large data file. When you scroll down, the top row disappears. It 

would be really helpful if the top row didn’t move so you could see the column headers regardless of 

where you are in the document. What do you do? Google it! 

 

Nine times out of ten, the first result is the most helpful. Your search results will also often remind you 

of the language used by Excel to help you fix your problem. For example, with this proposed issue, you 

would need to freeze the top row. Your search results should show you how. 

                It! 

If you are more of a visual learner, or need step-by-step support, watching a video on how to fix your 

issue is probably best. There are so many video resources out there for people using Excel.  

Example Issue: You are working on a monthly enrollment report and you want to be sure that all the 

clients in the report are for the current month. You need to sort your data by enrollment date, but you 

can’t remember how to make the sorting box appear. What do you do? YouTube it! 

 

You might find that YouTube results are a bit harder to navigate, but don’t let that get you down. You 

will usually find the answer you are looking for in the top three video results.  

 

This video, for example, is less than 9 minutes long and completely walks you through sorting and 

filtering of data – exactly what you would need to sort your workbook by enrollment date! 

Other Helpful Resources 

• Microsoft Office Excel Support – https://support.office.com/en-us/excel 

• Excel 2016 for Dummies – www.dummies.com/how-to/computers-software/ms-office/excel 

https://support.office.com/en-us/excel
http://www.dummies.com/how-to/computers-software/ms-office/excel
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Navigating a Workbook 

Parts of an Excel Workbook  

Scroll Bars 

Row 

Cell 

Colum

n 

Formula 

Bar 

Ribbon 

Tabs 

Worksheet Tab 
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Excel Ribbons Tabs: What is in Each One? 

“Home” Tab: This tab contains commands for common actions such as formatting, copying, pasting, 

inserting, and deleting columns and rows. 

 

Insert Tab: This tab contains commands that enable you to insert objects such as charts and shapes. 

 

Page Layout Tab: This tab holds all the commands that enable you to determine how your spreadsheet 

looks, both onscreen and when printed. These commands control options such as theme colors, page 

margins, and print area. 

 

Formulas Tab: This tab holds all the commands that help define, control, and audit Excel formulas. 

 

Data Tab: This tab features commands that enable you to connect to external data, as well as manage 

the data in your spreadsheet. 

 

Review Tab: With commands such as Spell Check, Protect Sheet, Protect Workbook, and Track Changes, 

the theme of the Review tab is protecting data integrity in your spreadsheet. 

 

0 



The Capacity Collective | Page 7 of 60 

View Tab: The commands on this tab are designed to help you control how you visually interact with 

your spreadsheet. 

 
 

 

Collapse the Ribbon 

If you don’t want to view the Ribbon so that you 

have more space to see your worksheet, select the 

small arrow in the bottom-right corner of the 

Ribbon.  The Ribbon contents will hide, but can be 

easily viewed again by clicking each Ribbon Tab. 

 

Pin the Ribbon 

If you do wish to view the Ribbon again, click any 

Ribbon Tab to show the Ribbon. Then, to pin it so 

that it does not hide, click the pin in the bottom-

right corner of the Ribbon. 

 

 

 

Helpful Keyboard Shortcuts in Excel 
 

 

  Keyboard Shortcuts 

 

OR 

 
: 

Move one cell to the left or 

right 

 

 

+ 

 

: 
Move to the farthest cell left 

(or right with the right arrow) 

in the row 

 

OR 

 
: Move one cell up or down 

 

 

+ 

 

: 
Move to the top (or bottom 

with the down arrow) cell in 

the column 

 

  : Go to the next cell 
 

 

+ 

 

: Go to the previous cell 

 

+ 
 

: 
Go to the most bottom right 

used cell 

 

 

OR 

 

: 
Move one screen up or down 

in a worksheet 

 

+ 
 

: 
Move to the beginning of a 

worksheet 

 

 

  : 
Go to the leftmost cell in the 

current row 

 

Tab Shift 

End Pg Dn Pg Up 

“Home” “Home” 
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Locking and Unlocking Cells and Worksheets 

Lock or unlock specific areas of a protected worksheet. 

By default, protecting a worksheet locks all cells so none of them are editable. To enable some cell 
editing, while leaving other cells locked, it's possible to unlock all the cells. You can lock only specific 
cells and ranges before you protect the worksheet and, optionally, enable specific users to edit only in 
specific ranges of a protected sheet. 

1. If the worksheet is protected, do the following: 
 
a. On the Review tab, click Unprotect Sheet (in 

the Changes group). 
 

b. Click the Protect Sheet button to Unprotect 
Sheet when a worksheet is protected. 
 

c. If prompted, enter the password to unprotect the worksheet. 
 

2. Select the whole worksheet by clicking the Select All button. 
 

3. On the Home tab, click 
the Format Cell Font popup 
launcher. You can also right click 
and press Format. 
 

4. In the Format Cells popup, in the Protection tab, uncheck 
the Locked box and then click OK. 

This unlocks all the cells on the worksheet when you protect the worksheet. Now, you can choose the 
cells you specifically want to lock. 

5. On the worksheet, select just the cells that you 
want to lock. 

6. Bring up the Format Cells popup window again 
(Ctrl+Shift+F). 

7. This time, on the Protection tab, 
check the Locked box and then click OK. 

8. On the Review tab, click Protect Sheet. 

Note: when protecting the sheet, in the Allow all 
users of this worksheet to list, choose the elements 
that you want users to be able to change. 
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Using Excel Scroll Bars 

The scroll bars in Excel can be used to move the worksheet both up and down and side to side. 
 

To Scroll Up and Down 

 
1. Locate the scroll bar on the right-hand side of the worksheet. There are two 

ways to use the scroll bar: 
 

a. Left click the up or down arrows at the top and bottom of the scroll 
bar area. Single clicks will move the scroll bar slightly. By holding the 
arrow down, you can keep the scroll bar moving without clicking. 
 

b. Left click on the scroll bar itself and hold the left mouse button down 
while dragging the scroll bar up and down.  

 

To Scroll Left and Right 

 
1. Locate the scroll bar on the lower right-hand side of the worksheet. There are two ways to use the 

scroll bar: 
 

a. Left click the Left or Right Arrows on either side of the scroll bar area. Single clicks will move 
the scroll bar slightly. By holding the arrow down, you can keep the scroll bar moving 
without multiple clicks. 
 

b. Left click on the scroll bar itself and hold the right mouse button down while dragging the 
scroll bar left and right.  

 
  



The Capacity Collective | Page 10 of 60 

Zooming In and Out 
 

Typically, when you open an Excel workbook, the view will be set to 100%. Adjust this to zoom in 
(making everything look larger) and out (making everything look smaller) of your worksheet.  
 
There are two ways to do this: 
 
Method 1: Use the Zoom Slider 
 
1. Locate the Zoom Bar at the bottom right-hand corner of the worksheet. There are two ways to use 

the Zoom Bar: 
 

a. Left-click on the dark gray vertical bar and drag it left 
(zoom out) or right (zoom in) 
 

b. Left-click the plus (zoom in) or minus (zoom out) signs on either side of the zoom bar 
 
Method 2: Use the “View” Ribbon Tab   

1. Locate the “Zoom” group under the “View” Ribbon Tab. It contains 

three options to quickly adjust your view of the spreadsheet: Zoom, 

100%, and Zoom to Selection. 

 

2. Click “Zoom to Selection” and either select your desired percentage 

zoom from the options or enter your desired value and click “OK”.  

 

Making Selections in Excel 

Select One or More Cells 

1. Click on a cell to select it. Or use the keyboard to navigate to it and select it. 
 

2. To select a range of cells:   
 

a. Method 1:  Select a cell, then with the left mouse button pressed, drag over other cells. 
 

b. Method 2: Use the Shift + arrow keys to select the range. 
 

3. To select non-adjacent cells and cell ranges, hold Ctrl and select the cells. 
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Select One or More Rows and Columns 

1. Select the letter at the top to select the entire column, or a number to the left of the row to 

select and entire row. 

 

2. To select multiple columns/rows:  

 

 Method 1:  Select a column/row, then with the left mouse button pressed, drag over the other 

left or right to select adjacent columns/rows. 

  

 Method 2: Select a column/row, and then use the Shift + arrow keys to select adjacent 

columns/rows. 

  

 Method 3: Select a column/row, and click and hold Shift, and select the last column/row that you 

would like to select. 

3. To select non-adjacent rows or columns, hold Ctrl and select the row or column numbers. 

Select All Data  

 

1. To select an entire worksheet, select any cell and press Ctrl + A. If it just selects a table, click Ctrl 
+ A twice and the whole sheet will select.  
 

2. To select the entire worksheet, click the “Select All” button at the top left corner. 

 

  

Keyboard Shortcuts 

 

+ 

 
: 

Extend the cell selection to the 

right 

 

 

+ 

 

: 
Extend the cell selection to 

the left 

 

+ 
 
: Select the entire row 

 

 

+ 

 

: Select the entire column 

 

+ 
 
+ 

  

Select the entire 

worksheet 

 
     

Space 

Shift 

Space Ctrl 

Ctrl 

Shift Shift 

Shift 

Space 
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Workbook Tabs: Creating, Duplicating, Moving, Renaming 

Inserting or Deleting a Worksheet 

Insert a Worksheet 
 

Method 1: Select the        plus icon at the bottom of the 

screen. 

Method 2: Select the ”Home” Ribbon Tab, find the 
“Cells” section, select “Insert” and select “Insert 
Sheet.” 

Delete a Worksheet 

Method 1: Right-click the Sheet tab at the bottom of 
the worksheet and select       “Delete.” 

Method 2: Select the sheet, and then select ”Home” 
Ribbon Tab, find the “Cells” section, select “Delete” and 
select “Delete Sheet.” 
 

 
 

 

 

  

Keyboard Shortcuts 

 

+ 

 
: 

Extend the cell selection to the 

right 

 

 

+ 

 

: 
Extend the cell selection to 

the left 

 

+ 
 
: Select the entire row 

 

 

+ 

 

: Select the entire column 

 

+ 
 
+ 

  

Select the entire 

worksheet 

 

     

Space 

Shift 

Space Ctrl 

Ctrl 

Shift Shift 

Shift 

Space 
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Move or Copy a Worksheet 

There may be times when you want to create a new Excel worksheet based on an existing worksheet. 
You can easily move or copy an entire worksheet in Excel to a new worksheet in the same file or even 
to a new, separate workbook file.  
 
Before you start making changes to a worksheet with data or information on it, it is best practice to 
make a copy. Making a copy will allow you to save a version of the worksheet that is the same as when 
you opened the file, so there no fear or mistakenly changing or deleting data. 

Move/Copy a Worksheet  

The easiest way to move a worksheet in the same workbook is simply to click and hold a worksheet tab 
a drag it to where you want it to land among the tabs in your workbook. 
To Move/Copy within the Workbook, or to another workbook: 

1. Select the tab that you wish to move or copy. 
 

2. Right-click the tab at the bottom of the worksheet, and select the 
“Move or Copy” option form the list.  
 

3. Decide if you are moving or copying the sheet. If you want to make a copy and leave the 
original alone, select the box in the bottom left corner of the call out box. 
 

4. Select the destination workbook from the dropdown menus 
“To book.” You can select the current workbook (the default), 
another existing workbook, or a create a new book to contain 
the moved or copied worksheet. You have to have the 
workbook open for it to appear in this list. 
 

5. If you are moving or copying the worksheet to the current or 
another existing workbook, select the worksheet before 
which you want to move or copy the selected worksheet in 
the “Before sheet” list. Select “(move to end)” to insert the 
worksheet after all the existing worksheets in the workbook. The new worksheet will appear 
before the worksheet that is selected and highlighted in blue.  
 

6. Click “OK” and you are done. Your worksheet will appear in the way you have designated! 
 
If you are copying the selected worksheet to the current or existing worksheet, the new worksheet is 
labeled with a sequential number at the end of the worksheet name to distinguish it from the original. 
For example, if you copy a worksheet called March, the new sheet will be called March (2). 
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Excel Tip: You can also select the worksheet and go to the “Home” Ribbon Tab, find the Cells 
section, and click on the Format dropdown. Then, select “Move or Copy Sheet” in the 
“Organize Sheets” section of the drop-down. Follow the other steps as above. 

Renaming Worksheet Tabs 

 

You may want to rename your worksheet tabs as a way of keeping them organized. This will help you 
keep track of what is contained in each worksheet within your Excel file. In this example, we have 
created a copy of a worksheet and now want to rename both. 
 

Method 1: Double-click the sheet name on the “Sheet” tab to quickly rename it. 
 
Method 2: Right-click on the “Sheet” tab, click “Rename,” and type a new name. 
 
Right-click on the worksheet tab you want to rename. Select 
“Rename” from the pop-up menu.  
 
The text on the selected tab will be highlighted in gray when it is 
ready to be edited.  
 
Use your keyboard to delete the old text and enter the new 
worksheet name. Hit Enter to save the new name.  
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Navigating Your Data: Finding and Replacing 

Finding Text 

Some commands in Excel are the same as in 
Microsoft Word. For example, you hit the Control 
Button and the letter F (Ctrl + F) at the same time 
to pull up the “Find and Replace” dialog box.  
 
Excel will search in whatever portion of the 
worksheet is selected.  
 

1. The column labeled “Funding” is selected to 
the left. Excel will only search for text that is 
in this column.  
 

2. If nothing is selected, the function will 
default to searching the entire worksheet. 

 
Type the text you are looking for and click the “Find Next” button. Excel will take you to the first cell 

that contains that text. Continue clicking “Find Next” to move through all cells in the column that 

contain that text. 

Example Explanation Type in the Finder 
(Ctrl+F under “Find what”) 

You are looking for only clients from the 

United States, but you know that the 

system often autocorrects to “Untied” 

instead of “United”. You want to find 

everywhere either “United” or “Untied” 

appears on the worksheet. 

A question mark 

matches any single 

character within a 

word 

You will type: un??ed 

The letter case does not matter. You 

will be shown all situations where 

the work format is un +two letters + 

ed.  

You are looking for a specific client, but 

are unsure how the name is spelled: is it 

Yennifer? Or Jennifer? Or Jenifer? 

An asterisk matches 

any sequence of 

characters. 

You will type: *en*fer 

You will be shown all of the cases 

where there are any number of 

letters + en + any number of letters + 

fer. 

 

If you want to find an actual question mark or asterisk, type a tilde (~) before the character. 
 

Excel Tip: You can use the wildcard characters— the question mark (?) and asterisk (*) — to 
look for information. See below for examples of how this could be useful. 
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For more options in the “Find and Replace” box, select 

“Options >>”.   

1. Change the “Format” to search only cells that are 

formatted in a certain way (to the left, Excel will 

find only orange cells that read “United States”. 

 

2. Change the “Within” dropdown to search within 

the Workbook vs. Worksheet.  

 

3. Change the “Look in” dropdown to 

control where Excel should look, 

including “Formulas”, “Values”, 

“Notes”, and “Comments”.  

 

4. Select “Find All” to see a complete 

list of results that match your 

search criteria.  

 

Finding and Replacing Text 

Another option Excel provides is the ability to find a specific value and replace it with another value. 

For example, you may want to change all the orange cells that read “United States” to “Canada” 

because these were all entered incorrectly.  

• Select “Replace”. 

 

• Enter what the new 

information will be in 

“Replace with”. 

 

• Select the “Replace” button 

at the bottom to replace 

them one by one, or select 

“Replace All” to replace all 

incidence of the text in the 

“Find What” box.  
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Freezing Panes 

It may be helpful to freeze data that you have in the top row(s) and first column(s) while looking at 
your data in Excel. For example, you may have headers in your top row, and client names in the first 
two columns. When you scroll down, you the headers can no longer be seen, and it is easy to lose track 
of what is in each column. When you scroll right, the client names are no longer visible, making it hard 
to keep track of which client you are observing. Fortunately, you can freeze as many rows and columns 
as you need to most easily navigate your data.  

 
1. Select the first cell you want to not be frozen. 

 

• All the rows above the selected cell will be 
frozen. 
 

• All the columns to the left of the selected cell 
will be frozen. 
 

Example: in the image to the right, cell C2 is 
selected. This means Columns A and B will be frozen, and Row 1 will be frozen.  

 
2. Navigate to the “View” Ribbon Tab. 

  
3. Click the “Freeze Panes” Button in the 

Window Group. Select “Freeze Panes” 
from the pop-up menu. 
 

4. To unfreeze the worksheet, return to the 
“View” Ribbon Tab. Click on the ”Freeze 
Panes” Button and select “Unfreeze 
Panes”. 

 

 
  

On a Mac (Using the Menu): → 

1. Highlight the row(s) or column(s), OR 

2. Select the cell from which you’d like to freeze 

the rows above and the columns to the left  

3. Select ‘Window’ from the Main Menu 

4. Select ‘Freeze Panes’ to freeze, OR 

5. Select ‘Unfreeze Panes’ to unfreeze 
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Columns and Rows: Spacing, Adding and Deleting, Hiding 

Adjusting Column Widths 

Depending on how you are using your worksheet, you may want to change the width of your columns. 
There are a few different ways to do this: 
 
Method 1: Drag Column to Change Width 
 
Select the column that you want to resize. Hover the cursor over the left or right 
edge of the column until you see a black cross with arrows on the horizontal 
arms. Left-click and drag column edge until it is the length that you want. 
 
Method 2: Auto-Adjust Column Width 
 
You can choose to set the column width to the width of the longest cell (based on content, like a long 
name) in the column. This is a good option when cells contain a limited number of characters. If the 
cell contains a lot of text, such as an open-end response field from a survey, this option may not be the 
best choice. 
 
Select the column that you want to resize. Hover the cursor over the left or right 
edge of the column until you see a black cross with arrows on the horizontal 
arms. Double left-click on the edge of the column header. The column will 
automatically resize to the widest cell. 
 

Set Column Width (One Column)  
 

Select the column that you want to resize. Right-click on the top of the 
column and select “Column Width” from the pop-up menu. 
  
Enter your new column width in the pop-up and click “OK”. 
 

Set Column Width (Multiple Columns)  
 

Occassionally, you might want to make all or 

some of your columns the same width.  

You may adjust multiple columns to the same 

width using the same method as with one. 

Select all of the columns that you want to resize. Left-click on the top of any of the selected column 

sand select “Column Width” from the pop-up menu.  

 

Enter your new column width in the pop-up and click “OK”. 

 

Note: if “#####” appears in a cell, simply widen the column and the information should appear! 
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Deleting Columns 

You may decide you do not need certain columns for the work you are doing. There are a couple of 
different methods to delete columns. Remember that deleting is permanent. Never delete something 
that you cannot re-pull from your database or another source. If you are not sure, hiding may be a 
safer option, or create a backup copy of the worksheet to safely make changes. 

 
Method 1: Delete Columns Using Ribbon Delete Button 

1. Select the column or columns that you would like to delete. 
 

2. Click on the “Home” Ribbon Tab.  
 

3. Click the Delete Button from the Cells Group on the “Home” 
Ribbon. Select “Delete Sheet Columns”.  

 
 

Method 2: Delete Columns with Right-Click 

1. Select the columns that you want to delete. 
 

2. Right-click on the top of the selected columns and then select 
“Delete” from the pop-up menu.  

 

Deleting Rows 

Deleting a row is very similar to deleting a column and can also be done one of two ways. 
 

Method 1: Delete Rows Using Ribbon Delete Button 

 
1. Select the row or rows that you would like to delete. 

 
2. Click on the “Home” Ribbon Tab. 

 
3. Click the Delete Button from the Cells Group on the “Home” 

Ribbon. Select “Delete Sheet Rows”.  
 

Method 2: Delete Rows with Right-Click 

 
1. Select the rows that you want to delete. 

 
2. Right-click on the top of the selected columns and then select 

“Delete” from the pop-up menu.  
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Inserting a New Column 

Sometime you need to add a new column into the middle of your worksheet. Maybe you want to 
create a formula, write notes, or paste in a column from another worksheet. Similar to deleting 
columns, inserting columns can be done two ways. 
 
Method 1: Insert a Column Using Ribbon Delete Button 

 
1. Select the column where you want to insert a new column. For 

example, if you want a new E column, select column E. 
 

2. Click on the “Home” Ribbon Tab.  
 

3. Click the Insert Button from the Cells Group on the “Home” 
Ribbon. Select “Insert Sheet Columns”.  

 
Method 2: Insert Columns with Right-Click 

 
1. Select the column where you want to insert a new column. For 

example, if you want a new E column, select column E. 
 

2. Right-click on the top of the selected columns and then select 
“Insert” from the pop-up menu.  
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Cut and Paste Columns 
At times you may want to reorder your columns so you can see the data in another order, or certain 
measures next to each other. You can do this by cutting the column and pasting it in a new location. 
There are two ways to do this. 
 

Cut and Paste into Blank Column 

 
1. Insert a new column using the instructions above. 

 
2. Select the column that you want to move and right-click. Select 

“Cut” from the pop-up menu.  
 

3. Select the first cell in the new blank column that you just created. 
Paste in the cut column by hitting the Control Button and the letter 
V (Ctrl + V) at the same time.  

 

Cut and Insert Cut Cells 

 
1. Select the column that you want to move and right-click. Select 

“Cut” from the pop-up menu.  
 

2. Select the column that is to the right of where you want this 
column to be. Right-click on the top of the column and select 
“Insert Cut Cells”.  

 

Hide and Unhide Columns 
Sometimes you will need to hide a column – or multiple columns – in order to see only the data you 
need at that moment. You can hide and unhide columns using various methods: 
 

Hide Columns Using Ribbon Format Button 

 
1. Select the column or columns that you would like to 

hide. 
 

2. Click on the “Home” Ribbon Tab near the top of  
the Excel window.  
 

3. Select the “Format” Button from the Cells Group.  

 

4. Select “Hide & Unhide” from the first pop-up menu.  
 

5. Select “Hide Columns” from the second pop-up 

menu. 
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Unhide Columns Using Ribbon Format Button 

 
1. To unhide columns, select the columns on either side of the hidden column. In this example, 

we have hidden column D. You can tell that column D is hidden by looking at surrounding 
columns, and seeing that D is skipped. 

 
2. Left-click on column C and drag your mouse over to 

column E while holding down the left mouse button.  
Both columns should be selected in gray. 

 
3. Select the “Format” Button from the “Cells” group on 

the “Home” Ribbon Tab.  

 

4. Select “Hide & Unhide” from the first pop-up menu.  
 

5. Select “Unhide Columns” from the second pop-up 

menu. 

 
 
 
 
 
 

  

Keyboard Shortcuts 

 

+ 
 
: 

Hide the selected  

rows 

 

 

+ 
 

: 
Hide the selected 

columns 

 

 

On a Mac (Using the Menu): → 

1. Highlight the row(s) or column(s) 

2. Select “Format” from the Main Menu 

3. Select Row > or Column > 

4. Select ‘Hide’ or ‘Unhide’ 

On a Mac (Using Right Click): → 

1. Highlight the row(s) or column(s) 

2. Right click 

3. Select ‘Hide’ or ‘Unhide’ 
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Hide Columns with Right-Click 

 
1. Select the column or columns that you would like to hide. 

 
2. Right-click on the top of the selected column. Select “Hide” from the 

pop-up menu.  
 

Unhide Columns Using Right-Click 

 
1. To unhide columns, you need to select the columns on 

either side of the hidden column.  
 
In this example, we have hidden column D. You can tell that 
column D is hidden by looking at the letter of each column. 

 
2. Left-click on column C and drag your mouse over to 

column E while holding down the left mouse button. Both 
columns should be selected in gray. 

 
3. Right-click on the top of the selected column. Select 

“Unhide” from the pop-up menu.  
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Designing: Font, Size, Color Lines, and Borders 
 

Excel has a default font, font size, and style to the text and numbers in a workbook. All of these options 

can be customized based on your needs. For example, you may wish to make titles a larger font size, or 

use bold to draw the eye to different sections of a worksheet. Many of the options for formatting a 

worksheet are available in the “Home” Ribbon Tab. Also keep in mind that the design functions in Excel 

operate just as they do in Word or other Microsoft products. 

Change Font Change Font Size 
        Change Position of Text  

    (Top, Center, Bottom) 

 

Bold Text Italicize Text Underline Text 
Change  

Font Color 

Change Text Alignment  

(Left, Centered, Right) 

 

To apply formatting to text, highlight all of the cells to which you want to apply the change, and select 
the formatting options by clicking on each type you wish to apply. 

 

Borders 
 

Draw lines and borders around cells, rows and/or columns with borders.  
 

1. Select the cell(s) to which you want to add a line or border 

 

a. Click on the “Borders” option from the “Home” Ribbon Tab. 

 

b. Select which portion of the selection to apply the line 

(bottom, top, left, or right) or select a type of border.  

 

c. You can customize the appearance of the line or border 

(thicker or thinner, dotted, or different colors) using the menu 

options. 

Format Painter 

One shortcut for quickly formatting is to use the Formatting Paint Brush.  

The Formatting Paint Brush is located on your “Home” Tab. If you look at 

the clipboard section (Left Side) of your “Home” Tab, you can find it. 



The Capacity Collective | Page 25 of 60 

How it Works 

 

When you select a cell or range and click on format painter button it 

copies formatting. 

After that, when you select other cells, it pastes formatting there. 

1. Select the range or cell from where you want to copy the 

formatting. 

 

2. Click on the format painter button. Once you click on the 

button, your cursor will convert into a paintbrush. 

 

3. Select the range on which you want to apply formatting. 

 

Formatting Text in Cells 

Alignment and Justification 

 

Control the appearance of your text by choosing both your alignment and justification in the “Home” 

Ribbon Tab: 

Alignment: 
Left Center Right 

Justification: 
Top 

Middle 
Bottom 

Together: 
Top Left 

Middle Center 
Right Bottom 

 

Merge and Unmerge Cells 

 

You may need to combine (merge) cells together to have text appear a certain way in a worksheet. You 

may also want to split (unmerge) cells that were formerly combined.  
 

Merge/Split Cells from Merge Dropdown in “Home” Ribbon Tab 

 

1. Highlight the exact cells you wish to merge, split or unmerge. 

 

a. Merge & Center: Combines the highlighted cells, and centers the text inside the cell. 

 

b. Merge Cells: Combines the highlighted cell into one cell 

 

c. Unmerge Cells: Restores combined cells into individual cells 
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Text Direction 
 

You can rotate the appearance of text to the level of the text direction in the “Home” Ribbon Tab. 

Regular Appearance 

C
lo

ckw
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2
5

%
 

C
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w
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e 

7
5

%
 

 

Text Wrapping 

 

When you type in more text than can fit in a column, Excel’s default is to show the text overlapping 

into the next cell(s). If you enter text into one of those adjacent cells, the text from the original column 

will no longer be visible. If you would like all of the text to be visible, you may want to use Text 

Wrapping. This will increase the size of the cell to adapt to the text, and show all of the text. 

Before Text Wrapping After Text Wrapping 

 

 

 

Excel Tip: For even more control over the appearance of text in a cell, use Alt + Enter to force 

the text after your cursor onto the next line. 
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Formatting Cell Contents: Types of Data 

Formatting Cell Contents 

 
Sometimes you may want to change the format of dates and numbers in your worksheet. This is also a 
great place for troubleshooting; if data is not appearing as expected, check to see how the data has 
been formatted—it may need to be updated to better reflect the data. 

 
Method 1: Format Using Menus  

 
1. Select the column or cells that contain the numbers or dates that you want to reformat. 

 
2. Click the gray down arrow in the white box in the “Number Group” 

of the “Home” Ribbon Tab. From the pop-up menu, select the type 
of number formatting you would like to do.  

 
3. Each number type includes several options. Explore these options 

to find what works best for you. Check out “More Number 
Options”!  

 
Method 2: Format Using Right Click 

 
1. Right click the cell or cells you wish to change. 

 
2. Navigate to “Format Cells…” in the “Home” Ribbon Tab. 

 
3. Select the format you wish from the list, and select “OK”. 

 

Formatting Content View 

 
You may want to change how a number appears in the cell. Follow the steps below to: 
 

- Make the value to appear as currency ($) 
- Make the value to appear as a percentage (%) 
- Include commas as thousands of separators (,) 
- Adjust the number of numbers after the decimal 

 
1. Navigate to the “Home” Ribbon Tab 

 

2. In the “Number” category, select the desired formatting. If 

you wish to change more than one cell, select all of the cells 

you wish to reformat before selecting the option. Note the 

options to increase or decrease the number of decimals.  
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Copying and Pasting 

Simple Excel Copy and Paste 

 

The simplest way to copy and paste in Excel uses the following steps: 

 

1. Select an Excel cell, or range of cells. 

 

2. Copy the cell(s) by either: 

a. Right clicking with the mouse and selecting “Copy” from this menu; 

b. Selecting the “Copy” option from the “Home” Ribbon Tab; 

 

3. Using the keyboard shortcut, Ctrl + C (i.e. hold down the Ctrl key and press C). 

 

4. Click on the location where you want to paste the copied cell(s). 

 

5. Paste the copied cell(s) by either: 

 

a. Right clicking with the mouse and selecting “Paste” from this menu; 

b. Selecting the “Paste” from the “Home” tab of the Excel Ribbon; 

 

6. Using the keyboard shortcut, Ctrl + V (i.e. hold down the Ctrl key and press V). 

 

Paste Options  

 

 

1. Paste Regular - Pastes everything you copied as it was copied. 

2. Paste Values - Pastes the result of the formula that was copied. 

3. Paste Formulas – Pastes only the formula(s) that were copied. 

4. Transpose - Data in rows is pasted into columns and vice versa. 

5. Paste Formats – Pastes only the formats that were copied. 

6. Paste Link - References the source cells instead of the copied cell. 

 

  

1      2     3      4     5     6 
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Copy a Pattern by Dragging 

 
In addition to copying text and formulas, you can drag cells to continue patterns. This is most helpful 
when you want to create a series of numbers or dates. 

 
1. To duplicate the same word or number in the subsequent cells, enter a 

number or date into the first cell. To duplicate a pattern, Excel will need 
to understand that pattern (e.g., 1, 2, 3 or 1, 2, 1, 2) so you will need to 
establish the pattern by entering data into the first several cells. If you 
have created a pattern over several cells, highlight all of them. 
 

2. Hover the cursor over the bottom right-hand corner of the cell until you see a black cross. 
  

3. Left-click and drag down while holding the mouse button down. 
The text will be copied.  
 

4. Click on the icon that appears on the bottom 
right-hand corner of the last copied cell. Select 
“Fill Series”. 
 

5. The number pattern will be continued through 
each cell.  

 

 

 

Excel Tip: You can copy a cell or a pattern by selecting the cell(s) you want to copy, then 

double clicking on the black cross (as described in step 2 above). 
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Inserting: Images, Text Boxes, Shapes, Icons 

Inserting an Image 
 

You can add images, such as a logo or header, to a worksheet.  

1. Click on the cell where you would like to insert the image.  

 

2. Select the “Pictures” dropdown menu from the “Insert” 

Ribbon Tab. 

 

3. Select “Photo Browser” to open a window to where you store your photos on your 

computer, or 

 

4. Select “Picture from File…” to browse to where the image is stored on your computer. 

 

Once you have inserted the image, you can change the size and alignment of the image. You can also 

edit the photo (in a few basic ways) in Excel. When an image is selected (by clicking on it), the “Picture 

Format” Ribbon Tab becomes available.  

 

From there you can format the image: 

 

• Align the image vertically (top, middle, bottom) 

• Align the image horizontally (left, center, right)   

• Crop the image (delete some portion)   

• Rotate the image (flip or rotate)   

• Change the size of the image 

 

 

 

 

 

 

Excel Tip: To keep your images from looking distorted, keep the “Aspect Ratio” checkbox 

selected. If you uncheck it, you will be able to stretch the image by changing one direction 

(e.g. width) without changing the other (height). You can find the “Lock Aspect Ratio” by 

clicking the down arrow. This will open “Format Picture”, where you can also adjust width, 

height, rotation, and scale.   
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Inserting a Text Box 

You can also add a text box to a worksheet. A text box can include 

an image or text, and can move around the worksheet without 

occupying a cell or disrupting data or formulas. The information in 

the text box will overlay the spreadsheet, so you can draw the eye 

to a specific point.  

1. Select the “Text” dropdown menu from the “Insert” 

Ribbon Tab. 

 

2. Select “Text Box”. If done correctly, your cursor should turn into an upside down ‘t’ shape. 

This indicates that you are ready to draw a text box within your worksheet.  

 

3. Click down and hold, while dragging your mouse to create the text box of your desired size.  

 

4. Use the “Shape Format” menu (which shows automatically when you have the box 

selected) to change the color, fill, border and other visual aspects of the text box. 

Click on the text box to change location, or to move it around the worksheet. You can shrink and grow 

the size of the text box by dragging the corners and/or sides in and out to the desired size. Click and 

hold the mouse button to drag the text box around the worksheet and place it precisely where you 

want.  

 

Inserting a Shape  

Similar to adding a text box, you can insert a shape anywhere in a 

worksheet, including inside of a cell or a text box (in order to be able to 

move it around). Excel has many standard shapes you can use, including 

various types of boxes and arrows, and some fun options like a smiley 

face and lightning bolt. 

1. Select the “Shapes” dropdown menu from the “Insert” 

Ribbon Tab.  

 

2. Use the dropdown options to select the type of shape you would like to enter. 

 

3. Click down and hold, while dragging your mouse, to create the shape of your desired size. 

 

4. Use the “Shape Format” menu (which shows automatically when you have the shape 

selected) to change the color, fill, border and other visual aspects of the shape.  

 

5. You can enter text in the shape, and use the settings to format that text as well. 
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Formulas 

Introduction to Formulas 

While formulas can be one of the more intimidating aspects of Excel, learning the basic of formulas will 

revolutionize the way you use the program, and how you use and understand your data.  

Microsoft says a formula is “an expression that allows you to make calculations to data in Excel”. Some 

formulas are very simple (see the example below), while others are complex. Excel has over 500 built-

in formulas in their library – don’t worry, you only need to learn a few to make your job easier!  

=SUM Formula: With this formula, you 

can add (or sum) multiple cells or rows 

of data. For example, if you could use 

this if you need to report to a funder 

how many home visits you completed 

last month. 

 

In an Excel formula, the equals sign (=) is what tells Excel that you are starting a formula. This will be 

how you start any formula you want to use.  

Likewise, parentheses are a required 

component of all Excel formulas; they put the 

parameters on what you are asking Excel to do. 

Element Description 

= 
The equal sign tells Excel that you are ready to start using a formula. You may start a 

formula in a blank cell, or in the formula bar. 

SUM 
In this example, SUM is the formula. You can tell that you are using a formula because a 

prompt will pop up, giving you the option to select which formula you’d like to use. 

( ) 
Parentheses are used in formulas to put parameters on the calculation you are looking to 

solve. In most cases, parentheses are found at the beginning and end of Excel formulas.  

D2 
In this example, D2 is the first value in the calculation you are looking to solve. This tells 

Excel that this is where you wish to start your calculation; with the value in cell D2. 

: 
In Excel formulas, a colon indicates “through” when it comes to data values. In this 

example, the formula indicates you want to calculate cells D2 through D8. 

D8 
In this example, D8 is the last value in the calculation you are looking to solve. Much like 

with D2, this tells Excel that you wish to end the calculation at this value.  
 

Excel Tip: You can use the same formulas and basic structures using cells from other 

worksheets! Just click on the worksheet you want to reference, select the cell you want to 

reference, and the formulas automatically changes format to include the cell. Ex: 

=SUM(D2:F2) would be =SUM(NEW_TAB!D2:F2)
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Top 15 Excel Formulas 

 FORMULA DESCRIPTION EXAMPLES 

1 =SUM 

One of the easiest and most important Excel functions. You can 

use this formula to calculate sum of a range of cells. This can 

include adding two cells together, or adding 200 cells together. 

See =SUM example above. 

2 =AVG 

As the name suggests, this formula allows you to calculate the 

average number from a range of cells. This formula can be 

applied to any numeric value found in your Excel worksheet. 

Finding the average number of “Home” visits for 

young parents compared to older parents. 

3 =MAX 

The =MAX function returns the largest value from a range. This 

is especially helpful when you have a large dataset and need to 

identify the largest or outlying values. 

Finding which children are the oldest, and 

therefore soonest to age out of the program. 

4 =MIN 

This function operates similarly to =MAX, but rather than 

identify the largest value, it returns the smallest value in the 

worksheet, or selected cells. 

Finding the clients with the lowest income to 

offer them access to a new resource. 

5 =COUNTBLANK 

This function counts the number of empty cells in a range. 

Empty cells are considered those that are blank, not those that 

have zeros. This is helpful when identifying missing data. 

Quickly finding how much missing data there are 

to assess data quality before starting reporting. 

6 =IF 

This is a must-use formula. It is relatively easy to use and very 

powerful. You can use this function to check whether a 

statement is true or false and return a value of your choosing. 
 

7 =SUMIF 

This formula is a combination of the =SUM and =IF formulas.  

It will sum values, if a certain condition is met. You select the 

cells you wish to sum, as well as which condition(s) must be 

met. 
 

8 =IFERROR 

The =IFERROR function can be applied to another formula 

allowing you to quickly and easily hide data return errors, by 

returning something else, such as a blank or zero. 

If you are making a list of client birthdays, but 

you know some will be missing, you can ask for 

“—” to appear rather than an error message. 
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9 =COUNTIF 

This formula is very similar to =SUMIF, but rather than 

summing values, it counts them. The count function counts the 

number of cells where certain condition is true. Much like 

=SUMIF, you determine the conditions that must be met.  

10 =CONCATENATE 

This basic string function allows you to combine two strings of 

text together. For example, you could use it to combine a 

user's first name and last name into a single cell.  

11 =YEARFRAC 

This calculates the fraction of the year represented by the 

number of whole days between two dates (the start_date and 

the end_date). For instance, you can use =YEARFRAC to 

determine a client’s age, or the amount of time a client has 

been enrolled in a program.  

12 =DATEDIF 

To get the number of days, weeks or years between two dates 

in Excel, use the DATEDIF function. The DATEDIF function has 

three arguments: start date, end date, and then “D”, “M”, or 

“Y” to indicate if you are looking for the difference in days, 

months, or years.  

13 =TODAY 

To enter today's date in Excel, use the TODAY function. To 

enter the current date and time, use the NOW function. To 

enter the current date and time as a static value, use keyboard 

shortcuts. 
 

14 =VLOOKUP 

The =VLOOKUP function allows you to search for a value in a 

column ("V" for vertical) and return another value from that 

same row. This can be especially valuable when you need to 

pull client information from a large worksheet of data. 
 

15 =HLOOKUP 

The =HLOOKUP function, similar to the =VLOOKUP function, 

allows you to search for a value in a row ("H" for "horizontal") 

and return another value from that same column. 

Similar to above, but Horizontal rather than 

Vertical (e.g. if the data were formatted with 

names above start dates). 
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Basic Formulas: SUM(), AVERAGE(), MIN(), MAX() 

Total (Sum) of a Column 
 

To find the total or sum of a row or column, you use the =SUM() function. You can use any cell 

to do this calculation; it does not need to be adjacent to the data being analyzed. 

 

1. Select the cell where you would like the sum 

to appear. 

 

2. Enter the formula directly into the cell or in 

the formula bar at the top of the sheet: 

=SUM( 

 

3. Indicate which cells you want to add together. 

You can click and drag and the cells will be added to the 

formula automatically, or type the cells in the formula. 

 

a. The colon “:” means through. If you want to add the 

values in cells V2 through V101, type “V2:V101”. 

 

b. The comma “,” means and. If you want to add cell V2 

and V101, and only those two cells, type “V2,V101”. 

 

4. Press Enter to get your results. 

 

Average or Mean of a Column 

 

To find a mean/average of selected cells, use the =AVERAGE() function. You can use any cell. 

1. Select the cell where you would like the sum to appear (can be anywhere!). 

 

2. Enter the formula directly into the cell or in the formula bar at the top of the sheet: 

=AVERAGE( 
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Excel TIp: Notice that Excel provides an explanation of the function for you. You can 
also click through the options to see which might work best. 

 
 

3. Indicate which cells for which you want to find an average. 

You can click and drag and the cells will be added to the 

formula automatically, or type the desired cells in the formula. 

 

a. The colon “:” means through. If you want to average 

the values in cells V2 through V101, type “V2:V101”. 

 

b. The comma “,” means and. If you want to average 

the values in cells V2 and V101, and only those 

cells, type “V2,V101”. 

 

4. Press Enter to get your results. 

 

Find a Minimum or Maximum Value 

 
To find the maximum or minimum of a set of values, use the =MIN() or =MAX() function. 

1. Select the cell where you would like the sum to appear. 

 

2. Enter the formula directly into the cell or in the formula 

bar at the top of the sheet: “=MIN(“ or “=MAX(“  

 

3. Indicate which cells from which you want to find the 

minimum or maximum value. You can click and drag 

and the cells will be added to the formula automatically, 

or type the desired cells in the formula. 

 

a. The colon “:” means through. If you want to analyze the values in cells V2 

through V101, type “V2:V101”. 

 

b. The comma “,” means and. If you want to analyze the values in cells V2 and 

V101, type “V2,V101”. 

 

4. Press Enter to get your results. 
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Combining Formulas: Nested Statements, Common Formula Errors 

Nested Statements 

 

Once you become more comfortable with various Excel formulas, you can start to combine 

them! These are known as “nested statements”. For example, you can find exactly where the 

missing values in your data are by combining IF and COUNTIF.  

• First, you use the COUNTIF function by asking Excel to find, in the range of data, a 

certain value you are interested in. But instead of stopping there, you “nest” this 

COUNTIF formula in a larger IF formula.  

 

• The IF formula would ask Excel to tell you, after it finishes the COUNTIF portion, if any 

individual cell you are interested in is missing a value.  

 

• This is particularly useful when you have a large dataset. If, for instance, you are 

combining data from two sources, and you are matching by individual ID numbers, you 

can use this kind of nested statement to find missing values.  

You would do this by creating two new columns: 

Individual ID #s Found 

12345 =IF(COUNTIF(range, value), “Ok”, “Missing” 

 
The “value” in the above nested statement is the cell number of the Individual ID number. 
Furthermore, the IF and COUNTIF combination can be used in a different way. Let’s say you 
want to find out whether a client is considered “High Needs” and thus, requiring at least two 
visits per month.  
 
For purposes of this exercise, let’s pretend that if a client has more than one “Yes’s” in Columns 
AH through AL, that client would be considered “High Needs”. For this example, create a new 
column called “High or Low Needs” in Cell AM1. In Cell AM2, write: 
 
=IF(COUNTIF(AH2:AL2, “Y”)>1, "High", "Low") 
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Then, populate Cells AM3 through AM101 with the same formula. This formula asks looks 

across the cells mentioned to see how many Yes’s (“Y”) there is/are. If it is more than one, the 

result will be “High”, and “Low” if otherwise. 

 

 
 

Common Excel Error Messages for Formulas 

 

Error Explanation How to Fix It 

#VALUE! 
When Excel finds spaces, characters or text 

in a formula when expecting numbers. 

Make sure words are in “”, no extra spaces, 

and that you aren’t trying to include empty 

columns. 

#NAME? 

When Excel doesn’t understand which 

formula, or element of formula, you are 

trying to run. 

Check spelling or use the Formula Builder to 

put together the formula. 

###### 
The column is not wide enough to show the 

value in the cell. 

Make the column wider (tip: double click the 

right border to auto fit width). 

#DIV/O 
When you are asking Excel to divide by zero 

(0) or an empty cell. 

Make sure you are using a value to divide; 

change the formula to use a cell with a value 

or add a value. 

#REF 

When Excel runs a formula using a cell that 

doesn’t exist (e.g. a deleted row, cell or 

column). 

Before you paste over cells, make sure there 

are no formulas referring to those cells. 

#N/A 

The numbers you are referring to in your 

formula can’t be found or cell not found in 

VLOOKUP. 

Check formula to make sure the sheet, 

column and row all exist and are referred to 

correctly. 

#NUM 

When your formula contains numeric 

values that aren’t valid (e.g. including $ 

symbol rather than formatting a number as 

currency). 

Check to make sure there are no commas or 

symbols--just the numbers themselves—in 

cells as well as formulas referring to the cells. 
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COUNT Formulas: COUNTBLANK(), COUNTIF() 

Count the Number of Blank Cells with the “=COUNTBLANK()” Formula 

  
This formula allows you to count the number of cells that 
are blank in a desired selection of data.  

 
1. Select the cell where you would like the number 

of blank cells to appear. 

 

2. Enter the formula directly into the cell or in the 

formula bar at the top of the sheet: 

=COUNTBLANK( 

 

3. Enter the location of the data you want the 

formula to search, either by clicking and dragging 

over the data or entering the range in. Be sure to 

close the parentheses.  

 

4. Press enter to get the result of the number of 

blank cells. If it reads “0”, there are no missing data. 

 

Count the Number of Times a Variable is Mentioned with the “=COUNTIF()” Formula 

 
Use this formula to find the number of times a specific text was entered into a set of values.  
For example, if you would like to determine how many mothers are in a given dataset, you 
might use the “=COUNTIF()” formula in the following steps: 

 
1. Select where you wish the number to 

appear.  
 

2. Enter the formula directly into the cell or in 
the formula bar at the top of the sheet: 
“=COUNTIF(“ 
 

3. Enter the data you would like to count from. 
  

4. Then, enter the criteria you wish it to count. That is, what is the formula looking for? 
This can be entered as a number (e.g. “32”), formula (e.g. “>32”), word (e.g. 
“Mother”), or a cell (e.g. J54). Note that text must be in “”. 
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You can also use the 
“=COUNTIFS” formula to see 
when two or more variables co-
occur. For example, how many 
of the BSK funded clients are mothers? For this, two criteria have to occur for the value to be 
counted (BSK Client from Column “I” AND Mother from Column “T”).  
 

Counting Continued 

 

You can also combine logical operators with the “=COUNTIF” and “=COUNTIFS” functions. For 

example, you can see how many clients who are children had more than three visits between 

January and March:  

=COUNTIFS(I2:I101, “Child”, V2:V101, “>3”) 

The greater than symbol is denoted by “>”. This, along with other useful symbols (e.g. “<” or 

less than, “>=” or equal or greater than, etc), is known as a logical operator. It acts as a 

connector between two things. In this case, we are asking Excel to find, between cells I2 and 

I101 AND V2 and V101, clients who are children AND who had more than three visits between 

January and March, respectively.  

 

Formula Symbols and Logical Operators 

 

> Greater Than < Less Than 

= Equals/Equal to >= Greater Than or Equal To 

<= Less Than or Equal To + Addition 

- Subtraction / Division 

* Multiplication : Through (A2:A14 = A2 to A14) 

$D$2 
When dragging formulas to subsequent rows, $ signs keep D2 in the formula rather than 

changing based on row 

$D2 Keeps the D in the formula by the number will change based on row 

“ “ 
To search for exact language (e.g. search for “BSK” in Funding column). NOTE: Logical 

operators must be included within the quotation marks (e.g. “>3”) 

<> Not equal to (e.g. countif <> “BSK” in Funding column to count other funding sources) 

AND 
Will return only answers that meet both criteria (e.g. Child AND BSK will only count 

children with BSK funding) 

OR 
Will return answers that meet either criteria (e.g. counts clients with either BSK or HVSA 

funding) 
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IF Formulas: IF() Formulas, Nested IF Statements 

IF Formulas 

The IF function is one of the most popular functions in Excel, and it allows you to make logical 
comparisons between a value and what you expect. 

An IF statement has two results. The first result is if your comparison is True, the second if your 
comparison is False. 

In the example above, the formula says: 
 

- If column “I” contains the text 
“Child,” column “O”, where the 
formula is being entered, should 
return the value “Yes”.  
 

- If column “I” does not contain the text “Child,” column “O” will return “No.” 
 

Excel Tip: Drag the formula down to have it apply to all the cells.  

 

Nested IF Statements 

 

=IF statements can also be nested. This is useful when you are assessing how who is at or above 

200% of the Federal Poverty Level (FPL). The elements you would need to build the nested =IF 

statements are: 1) income; 2) number in the household; and 3) the applicable FPLs.  

For purposes of this example, let’s assume the following is our data structure: 
 

 A B C D 

1 Monthly Income # in the Household Annual Income FPL Outcome 

2 $1000 2 =A2*12  

3 $4000 3   

4 $2500 4   

 

In D2, you would nest IF statements: 

 

 =IF(B2=1,C2/12140,IF(B2=2,C2/16460,IF(B2=3,C2/20780,IF(B2=4,C2/25100)….. 

 …..IF(B2=15,C2/72620))))))))))))))) 
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• The above asks Excel to tell you how far above or below the FPL each client is, 

depending on how many people are in the household (e.g. from one to eight).  

 

• Here, you would divide C (Annual Income) with the corresponding FPL. In 2018, the FPL 

for one-person household is $12,140, two-person household is $16,460, etc. You would 

do this for every type of household, from a one-person household to a 15-person 

household.  

 

• The Department of Human Health and Services (HHS) sets the poverty guidelines for 

number of persons in a household from one to eight (for household with more than 

eight persons, you would add $4320 for each additional person in 2018). To capture all 

possibilities, you can write the nested IF statement to include up to 15 persons.  

 

• If you know that you have a client that is in a larger household, you can adjust this 

formula accordingly.  

 

o In 2018, the poverty guideline for an eight-person household is $42380. Since 

the guidelines state that each additional person beyond an eight-person 

household is $4320, you would add that number to a nine-person household and 

get $46700, and so on. At the end of the above example nested IF statement, B2 

shows the number of persons as 15 and C2 shows the FPL as $72620.  

 

o The 15-person household FPL is derived from multiplying $4230 (the guideline 

for each additional person beyond an eight-person household) by seven (the 

number of persons beyond the eight-person household).  

 

• One of the important things to remember about nested statements is the parentheses!  

 

o Each part of the statement is “nested”, or a part of, another statement. So each 

time you use an open parenthesis to begin a statement, i.e. “IF(  “, you have to 

close the parenthesis in order for Excel to know that you have completed the 

function you want to run.  

 

o The slightly more complicated aspect in a nested statement is that the close 

parenthesis, i.e. “)”, is not going to be close to the open parenthesis. That is why 

we have so many of them at the end of the example nested IF statement! In fact, 

we have 15 of them, to be exact; this reflects the fact that the full formula, when 

written out, would have 15 statements, one for each of the type of household.  

You can change the format of the cells in Column D to “Percentage” so that you can easily see 

what each client’s FPL outcome is. For instance, after running the nested IF statements, D2 

would have returned 73%, D3, 231%, and D4, 120%.   
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More Formulas: YEARFRAC(),  

Change a date of birth to age with “=YEARFRAC()” Formula 

 
Use this formula to automatically calculate the age of a person when have their date of birth.  
For example, if you would like to know how old your clients are to easily organize your data, 
you could use the “=YEARFRAC()” formula in the following steps: 

 
1. Insert a column next to the Date of 

Birth column, and label it.  
 

2. Select the cell where you would like 
the information to appear.   
 

3. Enter the formula directly into the cell or in the formula bar at the top of the sheet: 
“=YEARFRAC(“ 
 

4. Enter the “start_date” where you would like to count from. In the example above, 
the start date is the date of birth that is in Column G, so the start date is G7.  
  

5. Enter the “end_date” where you would like the equation to count to. The equation 
will respond with how old the person is on the date that is entered here as the “end 
date.”  
 

a. In most cases, you would want to know how old the client is today, meaning 
that the value will change with each day. The information is always current.  
In the example above, the end date is set as today by entering the equation 
“TODAY()” as the end date. This age will automatically update based on the 
current date.  
 

b. In some cases, you may want to calculate the client’s age at some specific 
time. For example, you may want to know how old the client was when they 
ended services. In this case, you would enter the date they ended services 
for the “end_date”, or have the equation refer to another cell where the end 
date is present.  

 
You can also use the “=YEARFRAC()” formula in other situations to see the amount of time 
between any dates. For example, you many want to see how long a client received services by 
entering their enrollment date as “start_date” and exit date as “end_date”.  
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Searching for New Formulas: Start Typing, Formula Bar, Internet 

When looking for the formula you need, there are a few different ways to search.  

1. Google it. If you describe what you are trying to solve in Google, it will likely return 

some possible formulas and how to use them! 

 

2. Start typing. If you type the equals sign “=” and start typing the formula, notice that 

Excel provides a list of functions for you. As you click through each of them, a brief 

explanation of the function is provided. You may find an option that works well for 

what you need! 

 

3. Look at the “Formulas” Ribbon Tab. This tab organizes formulas into categories. You 

can look at the dropdown and explanations for each formula provided in each 

category.  

 

 

 
 

 

 

 

Excel Tip: After you start writing in a formula, the various segments of the formula 

appear. Each one should say what needs to be entered for the formula, each 

separated by a comma.   
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Sorting and Filtering 
Once you begin using Sorting and Filtering, it becomes quickly apparent how frequently these 
functions can simplify your job. Sorting and filtering both organize and declutter your data to 
hone in on what is most important to see as you are analyzing.  
 
Sorting: The sorting tool allows you to put the data into a particular order by date, number, 
alphabetic order and more.  

 
Example: You may have a list of clients and their enrollment dates. You can use the 
sorting feature to instantly put the clients in order of when they enrolled. 
 

Filtering: The Filter tool allows you to isolate particular data based on criteria you choose, and 
hides the rest, so you can focus on that data (e.g. those particular clients, or a specific group). 

 
Example: you want to look at only clients that are funded under the BSK grant, you could 
use the filtering tool to look only at these clients  
 

Sorting the Data 

Sorting can be used to quickly put data in alphabetical or numerical 
order. You can change the order of the contents of just the selected 
column, or you can have the entire row of data shift.  

 
1. Select the column you would like to sort.  

 
2. Navigate to the “Home” Ribbon and find the “Sort & Filter” 

dropdown under “Editing”.  
 

3. Select the sorting option you desire. 
 

4. A pop-up will ask you if you would 
like to “Expand the selection.” If 
the entire row of data belongs 
together, choose this option! For 
example, if you are alphabetizing 
names, you likely want all of the 
information in the columns to the 
right of the names to remain in the 
same row with the corresponding name. Select sort.  

 
 
Excel Tip: For more complex sorting, such as using multiple sorting rules together, 
select the “Custom Sort…” option from the drop-down menu.  
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Filtering the Data 

Filtering your data allows you to selectively see specific 
data you may want to see, and hide the rest. If can also 
quickly show you the data contained in a given column.  

 
1. Select the column(s) of data you wish to see. 

 
2. Navigate to the “Home” Ribbon Tab and find 

the “Editing” portion. 
 

3. Click “Sort and Filter”. 
 

4. Click “Filter” on the dropdown menu. 
 
5. An arrow should appear in the first row of the selected 

column. Click the arrow to display a list of all the values in 
that column. 

 
6. Scroll through the list of values to the bottom. Click 

“(Select All)” if you wish to then select only some of the 
values and have the others disappear.  

 

7. If you want to apply another filter (other than showing 
some of the values and not others, click 
on the “Number Filters” options.  
 
These filters allow you to filter the data 
selected based on the listed criteria.  

 

 
 

 

 

 

Excel Tip: if a column is filtered and not all data is showing, 
Excel reminds you of this by keeping a filter icon on the top of 
the column. This way you don’t forget you have hidden data! 
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More About Filtering 

 
Excel Tip: you can use the filter function to see if you 
have any missing or incorrectly entered data! 
 
 

How to: Scroll through the list of values to the bottom.  
 

• If a value appears that is misspelled, duplicated or seems 
out of place, select only those values and hit “OK”. You 
can then edit those values as needed in the “Sheet”. 
 

• If a value appears that reads “(Blanks)” at the bottom of 
the list, you know there is a missing value. You can click 
“(Select all)” at the top of the list to deselect. 
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Conditional Formatting 

Introduction to Conditional Formatting 

Conditional formatting allows you to apply specific formatting to cells that meet certain criteria. 
It is most often used as color-based formatting to highlight, emphasize, or differentiate among 
data and information stored in a spreadsheet. By using conditional formatting, all the values 
outside the range will change the formatting so they are easy to spot.  

 
1. Select the columns you would like to format.  

 
2. Navigate to the “Home” Ribbon and click on 

“Conditional Formatting” under Styles. 
  

3. You then can choose from the many options 
provided. To see what data is outside a certain 
range, select the “Highlight Cells” Rules option.  
 

4. Select the most applicable rule. 
 

5. Select the threshold value (all values greater 
than this value will be highlighted). 

 

 
 

6. On the right, you will find options for how you would 
like the cell to be formatted if the condition is true. 
Choose from the dropdown or choose “Custom 
Format…” to choose another format.   
 

7. Select “OK”. The values outside of the 
determined range should appear in the 
reformatted form.  
 

Examples of Conditional Formatting 

Light Green Fill with Dark Green Text  

Red Border Solid Fill 

 

Gradient Fill 
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Using the “Highlight Cell Rules” will isolate cells of data based on a criteria. For example, to 

quickly hone in on your clients who have not received the required 10 home visits in the past 

month, you could highlight the column with the number of home visits, and use the “Less than” 

option to highlight all of the clients who received less than 10 visits. 

Use the “Top/Bottom Rules” to quickly isolate the top (highest or most frequent) or bottom 

(lowest or least frequent) values in your data. For example, if you want to quickly determine the 

community needs (e.g. housing support, education resources) that have come up most often in 

conversations with clients, you could use the “Top 10 items” option to highlight those items.  

Highlight Cell Rules Top/Bottom Rules 

• Greater than 

• Less than 

• Between 

• Equal to 

• Text than contains 

• Top 10 items 

• Bottom 10 items 

• Top 10 % 

• Bottom 10 % 

• Above Average 

 

| ---------------------------------- 2-Color Scale ---------------------------------- | 

 | ---------------------- 3-Color Scale ---------------------- | 

Minimum | Maximum 

• Lowest Value 

• Number 

• Percent 

• Formula 

• Percentile 

Midpoint • Highest Value 

• Number 

• Percent 

• Formula 

• Percentile 

• Number 

• Percent 

• Formula 

• Percentile 

 

Data Bars are quick graphs you can apply to values to quickly get a visual representation of the 

values in reference to each other. 

Solid or Gradient Fill Solid or No Border Positive and Negative Values 
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Icon Sets can help you quickly identify patterns by using symbols and color to mark values. 

Icons can be Directional (e.g. arrows), Shapes (e.g. circles, triangles), Indicators (e.g. flags) or 

Ratings (e.g. stars, graphs). 

Icon Sets (Samples) 

 

  

  

  

  

 

Using Conditional Formatting for Data Quality 

If you know all your data should be within a certain range, you can use conditional formatting 
to show values that are outside of the reasonable range. For example, a birth year of 2118 
seems improbable. By using conditional formatting, all the values outside the range will change 
the formatting so they are easy to spot.  
 
Conditional formatting may be a useful way to get a quick 

initial understanding of your data. For example, say you 

want to get an idea of whether there is a difference 

between your BSK clients and other clients receiving the 

recommended number of “Home” visits in a given 

reporting period. You can do so visually by using 

conditional formatting.  

First, you would select the Funding Source column.  

• Go to Conditional Formatting in the “Home” 

Ribbon, choose “Highlight Cells Rules”, and choose 

“Equal To…”.  

• In the field next to the dropdown menu of “equal 

to”, type in “BSK”.  

• You can change the color if you wish (the default is 

“Light Red Fill with Dark Red Text”).  

• Click “OK”. This would highlight all the BSK cells in light red. The non-BSK clients would 

not be highlighted. 
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In the [hypothetical] “Number of “Home” Visits” column, you can use one of the Conditional 

Formatting presets, “Icon Sets”.  

• Try the first option, “3 Arrows (Colored)”.  

• Excel would divide the values in this column into three categories of values:  

- below average (denoted by the red, downward-facing arrow),  

- average (denoted by the yellow, horizontal arrow), and  

- above average (denoted by the green, upward-facing arrow).  

• You can try different options (e.g. indicators, etc) or presets (e.g. Data Bars, Color 

Scales), to get a sense of what you might find more useful or appealing. 

 

Conditional Formatting Rules Manager 

The Conditional Formatting Rules Manager will allow you to add, edit and delete rules, and 

apply multiple rules to the same dataset. Note: the most important rules go on top, and the 

order descends according to importance. 

 

 

Excel Tip: Once you have chosen a conditional format, Excel remembers it. 

Therefore, if you want to change the format, you must delete the existing format 

first by going back to the Conditional Formatting dropdown menu, and selecting 

“Clear Rules” and choosing the appropriate cells or the entire sheet.  

 

Excel Tip: You can even complement the conditional formatting function with the 

SORT function (putting all the BSK funded clients together) to make it easier to see 

what your data say!  
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Tables and Graphs 
 

There are many ways to visually display data. Before you insert a chart, think about whether 

the data are best presented as a chart. Sometimes, depending on what you are trying to 

convey, the data may not be very useful when they are displayed visually.  

You can use the “Recommended Charts” function in Excel as a starting point; most of the time, 

if you are looking to display two variables (e.g. number of children screened during the 

reporting period and children age groups), it will recommend the column chart. In many 

instances, that would be an appropriate type of chart to use.  

Here are some ways to think about the differences between the chart types, if you determined 

that the column chart is not the most appropriate chart to use: 

Types of Charts 
 

Type of  

Comparison 
Explanation Example Type(s) of Chart 

Time Series 

How a variable 

changes over 

time 

Number of clients 

served every 

month in 2019 

Column or line chart; the x-axis 

(horizontal axis) would mark the 

passage of time 

 

TIP: if the number of time 

categories is high (i.e. over 20), 

consider using the line, instead 

of the column, chart 

Parts of a 

Whole 

Disaggregation: 

looking at the 

breakdown of a 

single variable 

The proportion of 

children in each 

age category. 

 

or 

 

The proportion of 

caregivers in each 

race category. 

Column, bar, or pie chart 

 

TIP: if the number of categories 

is high, and many of the values 

are small, stay away from the 

pie chart as it will not be able to 

display those values well; 

instead, use the column or bar 

chart since you will be able to 

adjust the scale on these charts 

Association/ 

Correlation 

How one variable 

may be related 

(or not) to 

another variable 

Comparing number 

of caregiver job 

status (Variable 1) 

and percentage of 

completed “Home” 

visits (Variable 2) 

Scatter Chart 

 

TIP: for the most part, you 

probably won’t need to show 

correlation between two 

variables for your analyses 
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Tables 

Making a Table 

 

1. Locate the data you wish to make into a 
table and select it by clicking and dragging.  
 

2. Go to the Insert Ribbon Tab and select 
“Table” in the “Tables” category.  
 

3. Select if your table has headers or not. 
Select “OK”. 

 
4. Navigate to the “Table Design” Ribbon Tab to change 

the styles and view other options.  
 

5. To view additional options, including adding a row to 
provide a total or average, add conditional formatting, 
or change the table to a chart, select the entire table, 
click the icon that appears in the 
bottom right corner, and select your 
desired option.  
 

Graphs 

Making a Bar Graph 

 
Once you have a table (or data organized in a 
table-like format), it’s easy to make a graph! 
 

1. Select the data you would like to include in the graph. 
 

2. Navigate to the “Insert” portion of the Ribbon.  
 

3. \Select the kind of graph you wish to use from the drop-
down options in the “Charts” portion of the Ribbon.  
 

4. Once you select your desired graph type and press 
enter, the graph should appear.  

 
5. Now you can edit and customize your graph. 

a. Click on each element to delete or edit each 
element. 
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b. Under the “Chart Design” Ribbon Tab, add in chart elements 
with the “Add Chart Element” drop-down on the far left of the 
Ribbon under “Chart Layouts”.  

 
6. For additional options, select the graph figure and three icons will 

appear to the right of the graph.  
a. The first is a plus sign, were you can 

quickly add and eliminate elements of 
your chart. 
 

b. The second is a paintbrush, to quickly 
make style and color changes (also see 
the “Chart Design options on the top 
Ribbon). 
 

c. The final is the filter icon, where you can 
quickly remove data and click “Apply” to 
revise what data the graph is showing. 

 
To change the data itself, navigate to the “Chart Design” 
Ribbon Tab, where you have additional options in the 
“Data” section on the righthand side.  

 
To change any specific element of the graph, right click 
on the element itself on the graph and you will be 
provided with additional options. 
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PivotTables 

Introduction to Pivot Tables 

 

Pivot Tables rival Formulas as one of the most powerful tools that Excel has to offer. Similar to 

most advanced Excel functionality, Pivot Tables can seem intimidating. We want to help change 

that. Learning the basic of Excel Pivot Tables will completely alter the way you use Excel, and 

how you analyze your data. Let’s start with the basics – what is a Pivot Table? 

 

A Pivot Table is a table of outcomes that summarizes the data of a more extensive table. In 

short, think of a pivot table as a quick-report. Keep in mind that unlike a traditional report, a 

Pivot Table provides you with an interactive view of your data. With very little effort (and no 

formulas!) you can look at your data from many different perspectives. You can group data into 

categories, break down data into years and months, filter data to include or exclude categories, 

and even build charts. 

 

Pivot Tables can produce tables that are appropriate for presentations and reports. They help 

you to “slice the cookie”—to show your data, based on other aspects of your data. For 

example, rather than just showing a list of funders (one data point), or giving a number of 

clients (one data point), you can show the number of clients by funding source (combining two 

data points together). 

 

In this example, the Pivot Table is showing how many clients 

are being funded by each funding source: BSK is funding 5 

clients, TANF is funding 2 and Title 1 is funding 2, with a total of 

9 clients. 

 

How to Create a Pivot Table 

 

1. The first thing you need to create a Pivot Table is a ‘dataset’. In most cases, this is a 

spreadsheet of data that you exported from your database. See example below. 
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2. The next step in creating a Pivot Table is selecting and inserting the data you would like 

pulled into your Pivot Table by going to Insert → Pivot Table. Once you’ve made that 

selection, the prompt box (as seen below) should appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Key Description 

1 

When the ‘Create Pivot Table’ box appears, the first thing you need to verify is that 

the correct dataset is selected. In this example, our dataset is columns A through H 

and rows 1 through 10. 

2 
If you want to pull in data from another Excel file, you can use an external data 

source. This allows you to have at least one other Excel file open and available for use.  

3 

Before completing your Pivot Table, you must select where you would like it to go in 

your Excel workbook. To create a new worksheet (one you have not started yet), 

select the ‘New Worksheet’ option. Many Excel users create a new tab in their 

workbook called ‘Pivot Tables’ and link all pivot tables here. It allows you to keep all of 

your Pivot Tables in one organized place. To do this, create a new tab called ‘Pivot 

Tables’ prior to creating your actual Pivot Table. When prompted to select your 

location, go to your new tab, and select a cell within the worksheet. 

 

3. Using the drag-and-drop functionalities of Pivot Tables, decide which variables you 

would like to use to create your Pivot Table “report”. In the example below, I am 

wanting to quickly see how many clients are funding through each available funding 

source.  

 

1 

2 

3 
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By making my ‘Rows’ (vertical) = Funding Source, and my Values (what you want to count) also 

= Funding Source, I am telling Excel that in my rows, I want to see all possible funding sources, 

and in my columns, I want to see the total number of each funding source in my selected 

dataset. See below. 

 

 

 

 

 

 

 

Pivot Table Tips & Tricks 

 

When making Pivot Tables, it is important to remember your rows and columns. When using 

single variable Pivot Tables (see example above), you will likely put your desired variable in both 

the ‘Rows’ box and in the ‘Values’ boxes.  

 

 

 
Multi-Variable Pivot Tables 

 
Adding multiple variables to your Pivot Table is quite simple. To do this, follow each of the steps 
listed above, but rather than thinking though which one variable you’d like to see analyzed, 
choose two variables that you would like to see analyzed together.  
 
Example Scenario: You want to know the race and age breakdown of your clients, and while you 
could make two Pivot Tables, one for race and another for age, it’s more interesting to see how 
these two variables intersect with one another. Counting variables independently of each other 
will only get you so far. 
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What you have now is what is commonly referred to as a crosstab, or a visual representation of 
how these two variables intersect. Interpreting Pivot Tables can be a bit confusing, so take the 
time to make sure you understand the output.  
 
If simple counts are not helpful, you can customize your output. For example, if knowing the 
percent of each race/age breakdown is more helpful, update your output format. 
 

  
 
Excel provides a variety of options for formatting your data. The most common basic formatting 
of Pivot Tables are ‘Count’ and ‘Sum’. For Pivot Tables with multiple variables, you can apply 
more complex formatting, including ‘Percent of Grand Total’ and ‘% of Parent Total’.  
 
See examples of these different formats on the following page. Keep in mind, the way you 
display your data depends on which question you are more interesting in answering.  
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In this example, using the ‘% of 
Parent Column Total’ will show you 

how many clients of each racial 
category fall into each age category. 

This is indicated by each row 
totalling 100%. 

 

In this example, using the ‘% of 
Parent Row Total’ will show you 

how many clients of each age 
category fall into each racial 

category. This is indicated by each 
column totalling 100%. 

 

Applying Filters to Pivot Tables 

 

Depending on the size of your dataset, Pivot Tables can sometimes be a bit overwhelming. One 
way to avoid your output becoming too cumbersome is to apply filters to your Pivot Tables to 
narrow down what data is presented. 
 
TO apply a filter to your data, drag-and-drop the variable you would like to treat as your filter 
into the ‘Filters’ section of the Pivot Table Fields. 
 

 

 

 

 

 

 

In the example above, a Relationship filter was applied to only show 
the gender breakdown of the children in the dataset. When applying a 
filter, you will only be able to narrow down your data by the options 
made available in your dataset. For example, when narrowing the data 
down by Relationship, the only options in the filter selection were 
Child, Father, and Mother. If your data had more options, this would 
reflect in your filters.  
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Printing 

Printing a Worksheet 
 

Printing from Excel is highly customizable; you can select exactly what part of the worksheet 

you want to print, and control how it looks printed. You can use the “Page Layout” Ribbon Tab 

to make most adjustments related to printing. 

Change Margin Size Change Page Size Set/Clear Print Area        Print to Number of Pages 

 

 

 

 

Switch Between Portrait and Landscape Page Orientation Choose to Print Gridlines/Headings 

Set/Clear Print Area 

 

To only print specific cells, highlight the full area you want to print, and click on the “Print Area” 

dropdown menu from the “Page Layout” Ribbon Tab. Select “Set Print Area” to set those 

specific cells as the portion that will be printed, or “Clear Print Area” to go back to printing all of 

the occupied cells (which is the default). 

Print to Number of Pages 

 

You can ask Excel to shrink or expand the way the worksheet 

prints to fit on a particular number of pages. You can choose 

by how many pages wide you want the printed document 

using the Width dropdown menu, and/or how many pages 

long you want the printed document using the Height option.  

File > Print Options 

 

You can also customize many of the printing options in the 

Print Dialog Box (File > Print).  

Print Active Sheets, Selected Cells or Entire Workbook 

Change margin size (Normal, Wide, Narrow) 

Scale to Fit Set Number of Page 


